DC260

Visual Presenter

User Manual

[Important]

To download the latest version of Quick Start
Guide, multilingual user manual, software, or
driver, etc., please visit Lumens
http://www.lumens.com.tw/aoto.htm

http://www.lumens.com.tw




Contents

Copyright Information.........cccccviiiii s ——— 3
Chapter 1 Precautions........cccccciiiiiinnnirr e 4
Chapter 2 Package Content..........cccccmiiiiicciicmrmnrinsssssssserree s s ssssssee s eesenses 7
Chapter 3 Product OVerview..........cooiciiinmenre s 8
3.1 Relative position of the presenter and DC260 .............cccccceeeieernnnnes 9
3.2 Recommend distanCe...........cccoiiiiiiiiiiiiei 9
3.3 INCOIMECL USE ... e e 10
Chapter 4 Installation and Connections........cccccocccccciererienncccccecseee e, 1"
4.1 System diagram ......cceeiiiiiiiie e 11
4.2  Mounting the DC260 at deskiop........cccvviiiiiiiiiiee e, 12
4.3  CoNNECNG AEVICES .....coieiiiiiieiiiiiie ettt 12
4.4  Start using the DC260 ...........cooiiiiiiiiiiiie e 16
4.5 Installing remote control holder ..., 16
4.6 Installing driver and application queue............cccoceeiiiie e, 17
Chapter 5 DIP Switch Settings .......cccooiiiiiiiie e 21
5.1 Connecting to a projector or monitor..........cccoeveeiiiiieieiee e 21
52  Connecting 10 @ TV . .uiiii i 22
Chapter 6 Control Panel/Remote Control and Setting Menu ................... 23
6.1 Functions of control panel and remote control ...............ccccccvvvieeeen... 23
6.2 Setting MENU ......ooiiiiiiii e 25
Chapter 7 Descriptions of major functions ............cccccriicecerircccennsscceee e 31
7.1 1 would like to switch image SOUICeS ........cccceeiiiiiiiiiiiiiie e 31
7.2 | would like to make text clearer and photos more colorful................ 31
7.3 | would like to zoom in /out of IMAgES ........ovevviiiiiiiiiiie e 31
7.4 | would like to use the auto fOCUS ........ccceeveveeiiiiiiiii e, 32
7.5 | would like to adjust the brightness ..........ccooiiiii 32
7.6 | would like to turn on/ off the lamp.........occociiiii 32

Lumens English - 1




7.7 1 would like to automatically adjust the image to have best

brightness and focusing performance............ccccocccveeiiceeeeeciee e, 32
7.8 | would like to capture images.........cceeeeiieiiiiiiieie e 32
7.8.1 Setting the quality of captured images........c.ccccceveviieeeenciiee e 32
7.8.2 Setting continUOUS CapUure.........ccooiiiiiiiiiiiii e 33
7.8.3 Capturing and Saving iMagES .........ccuereeiiiiieeiiiieeseieeeeseeeeesieeeee s 33
7.9 | would like to view captured images.........ccccooueeeiiiiieiniiiiee e 33
7.10 | would like to delete captured images.........c.cooeeiiiiiieieiiiniiiiieee. 33
7.11 | would like to automatically delete the captured images whenever

it is turned off (AUtO Erase)........cccoveeiiiieiiiiiie e 34
7.12 | would like to record and play Videos .........cccccueeiiiiiiiiiniiiieieee, 34
7.13 1 would like to switch the view between the upper and lower half

of the image (Half Page) .........ooooiiiiiiii e 35
7.14 | would like to play the slides (Slide ShOwW) ...........cccocviviiiieiiiiienee 35
7.15 | would like to compare images (Compare live images with

captured images) (PBP, Picture by Picture) ..........cccccoveieveiiiinenennnns 36
7.16 | would like to resume the factory default setting (Factory Reset).... 37
7.17 1 would like to reduce the image noise (Noise Reduction)................ 37
7.18 | would like to set / change the password (Lock Down).................... 38
719 USING @ SD Card ...eeeiiieeciiiee ettt 39
7.20 Computer-related fUNCLONS .........ccoociiiiiiiiii e 40
7.20.1 1 would like to insert a photo in MS-Paint............cccoceeeeeiiiecccinnnnn.... 40
7.20.2 | would like to insert a photo in MS-Word...........ccccocoeiiiiiiiin, 41
7.20.3 | would like to change the setting of DC260 then capture a photo

IN MS-WWOIA.....coooieiieiiee e 42
7.20.4 | would like to set the DC260 as a webcam for Skype..........ccc....... 43
7.20.5 | would like to set the DC260 as a PC Camera..........ccccccoeeeevnieeennn. 44
7.20.6 | would like to set the DC260 as a Removable Disc .............ccc........ 45
7.20.7 | would like to connect Interactive Whiteboard..............cccoceeiniienne 46

Chapter 8 Connecting to MiCroSCOPe.........ccceririmmmrinsssmsrnnssne e 48
Chapter 9 Troubleshooting.........ccccciiiriiiniiniisn 50

Lumens English - 2




Copyright Information

Copyrights © Lumens Digital Optics Inc. All rights reserved.

Lumens is a trademark that is currently being registered by Lumens Digital Optics
Inc.

Copying, reproducing or transmitting this file is not allowed if a license is not
provided by Lumens Digital Optics Inc. unless copying this file is for the purpose
of backup after purchasing this product.

In order to keep improving the product, Lumens Digital Optics Inc. hereby
reserves the right to make changes to product specifications without prior notice.
The information in this file is subject to change without prior notice.

To fully explain or describe how this product should be used, this manual may
refer to names of other products or companies, nevertheless without any intention
of infringement.

Disclaimer of warranties: Lumens Digital Optics Inc. is neither responsible for any
possible technological, editorial errors or omissions, nor responsible for any
incidental or related damages arising from providing this file, using, or operating
this product.
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Chapter 1 Precautions

Always follow these safety instructions when setting up and using the visual presenter:

asrowbdh-

o

10.

11.

12.

13.

14.

Do not place visual presenter in tilted position.
Do not place the visual presenter on an unstable trolley, stand or table.
Do not use the visual presenter near water or source of heat.
Use attachments only as recommended.
Use the type of power source indicated on the visual presenter. If you are not sure of
the type of power available, consult your dealer or local electricity company for
advice
Place the visual presenter on a place that it can be unplugged easily.
Always take the following precautions when handling the plug. Failure to do so may
result in sparks or fire.

W Ensure the plug is free of dust before inserting it into a socket.

B Ensure that the plug is inserted into the socket securely.
Do not overload wall sockets, extensions leads or multi-way plug boards as this may
cause fire or electric shock.
Do not place the visual presenter where the cord can be stepped on as this may
result in fraying or damage to the lead or the plug.
Unplug the projector from the wall socket before cleaning. Use a damp cloth for
cleaning. Do not use liquid or aerosol cleaners.
Do not block the slots and openings in the projector case. They provide ventilation
and prevent the visual presenter from overheating. Do not place the visual presenter
on a sofa, rug or other soft surface or in a built-in installation unless proper ventilation
is provided.
Never push objects of any kind through cabinet slots. Never allow liquid of any kind
to spill into the visual presenter.
Except as specifically instructed in this User Manual, do not attempt to operate this
product by yourself. Opening or removing covers may expose you to dangerous
voltages and other hazards. Refer all servicing to licensed service personnel.
Unplug the visual presenter during thunderstorms or if it is not going to be used for
an extended period, do not place the visual presenter or remote control on top of
heat-emitting equipment or heated objects such as a car and etc.
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15. Unplug the visual presenter from the wall outlet and refer serving to licensed
service personnel when the following situations happen:
| If the power cable or plug becomes damaged or frayed.
| If liquid is spilled into it or the visual presenter has been exposed to rain or
water.

<Note> Using an incorrect battery type in the remote control may result in
breakdown. Follow your country’s instructions on how to dispose of used
batteries.

B Safety Precautions

Warning: To reduce the risk of fire or electric shock, do not expose this
appliance to rain or moisture.

This visual presenter has a 3-wire AC line Plug. This is a safety feature to ensure that the
plug will fit into the power outlet. Do not try to disable this safety feature.
If the visual presenter will not be used for a long period of time unplug it from the power

outlet.

CAUTION
RISK OF ELECTRIC SHOCK

Caution: To reduce the risk of electric shock. Do not remove cover (or back). No
user-serviceable parts inside. Refer servicing to licensed service Personnel.

This symbol indicates that This symbol indicates that
this equipment may there are important operating
contain dangerous and maintenance instructions
voltage which could in this User Manual with this
cause electric shock. unit.

B FCC Warning

NOTE: THE MANUFACTURER IS NOT RESPONSIBLE FOR ANY RADIO OR TV
INTERFERENCE CAUSED BY UNAUTHORIZED MODIFICATIONS TO THIS
EQUIPMENT. SUCH MODIFICATIONS COULD VOID THE USER'S AUTHORITY TO
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OPERATE THE EQUIPMENT.

Note: This equipment has been tested and found to comply with the limits for a Class A or B
digital device, pursuant to Part 15 of FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instruction, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

* Connect the equipment into an outlet on a circuit different from that to which the

receiver is connected.

* Consult the dealer or an experienced radio/TV technician for help.

Notice:

(1) A Unshielded-type power cord is required in order to meet FCC emission limits
and also to prevent interference to the nearby radio and television reception. It is
essential that only the supplied power cords by used.

(2) Use only shielded cables to connect I/O devices to this equipment.

(3) Changes or modifications not expressly approved by the party responsible for

compliance could void the user’s authority to operate the equipment.
B EN55022 (CE Radiation) Warning

This product is intended for use in a commercial, industrial, or educational environment. It

is not intended for residential use.

This is a Class A product. In a domestic environment it may cause radio interference, in
which case the user may be required to take adequate measures. The typical use is in a
conference room, meeting room or auditorium.
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Chapter 2 Package Content

Quick Start Guide User Manual

N b sl
Base Installation Remote Control Power Cord
Guide
8
-
(=X-XX-)
[=X-X-X-}
Appearance may vary with
country/region.
Software Bag VGA Cable USB Cable
Lumens’ ‘h
C-Video Cable Remote Control Microscope Adaptor

Holder

Padded Carry Bag RS232 Adaptor

(Optional) (Optional)
B

(&) =
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Chapter 3 Product Overview

g TTTTPTTPPIPPPITP PP PP » 8. Gooseneck

b
A S \.\. ................. » 7. AF button

1. Lamp

SOURCE POWER

2. Remote sensor

LAMP AUTO TUNE

ZOOM +

FOCUS - ENTER FOUCS +

6. DIP switch

T

(Bottom)
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3.1 Relative position of the presenter and DC260

DC260

Presenter

Documel

-

3.2 Recommend distance

About 470mm distance between camera and the desktop is recommended.
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3.3 Incorrect use
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Chapter 4 Installation and Connections

4.1 System diagram
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—— SD Card
Speaker (or an
amplifier before
connecting to the
speaker)
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4.2 Mounting the DC260 at desktop

1. Please set up the DIP Switch settings first. Refer to Chapter 5 “DIP
Switch Settings” in the DC260 user manual.

2. Please refer to the Base Installation Guide for installation instructions
for all parts.

4.3 Connecting devices

4.3.1 Step 1: Plugging in the power outlet AC Outlet

<Note> Appearance of power cord may vary with countries/regions.

4.3.2 Step 2: Connecting with components
» Connecting to a projector or monitor
® Use VGA cable to connect VGA OUT connector on DC260 to a

projector or the VGA IN connector on a monitor.

3@\\ ,}_C”x_/[

VGA QUT C-VIDEO OUT

I

— 1=

» Connectingtoa TV
1.Use C-Video cable to connect TV.

(@
) T
J

e /@\’ ”x_/ [ ] ’@
VGA OUT C-VIDEO OUT | R

— =
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2.Adjust DIP Switch Setting
B NTSC: America, Taiwan, Panama, Philippine, Canada, Chile, Japan, Korea and

Mexico

C-Vlideo PAL

> T a3 ¢

I
1
RGB XGA 60Hz NTSC

B PAL: Country/region not listed above:

C-Vlideo PAL
|

1 1

: T35 4

I
1
RGB XGA 60Hz NTSC

<Note> You are unable to use the [Menu] / [Rotate] / [Half Page] /
[Source] / [Record] / [Capture] / [Delete] / [PBP] / [Slide Show]
functions in C-Video mode.

<Note> VGA output is not supported once C-Video output enabled.

3.Restart the DC260
DIP Switch setting will not be available until restarting the DC260.
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» Connecting to a LCD TV/ PDP
® Using the HDMI cable to connect a LCD TV/ PDP

TN
/ \

[ —

(~o i
=[] ©°

HDMIOUT /JSB  RS232 PHONE

» Connecting to a computer
® Use VGA cable to connect VGA IN connector on DC260 to the VGA

OUT connector on the computer

® Connecting to a computer through USB

Connect to USB port. Then install the supplied queue program. Please refer
to DC260 User Manual 4.6 Installing driver and application queue.

N
& : input \l;
Qutput
[ = p - K
QD © i
(E?Dl D ©

HDMI QLT USB /15232 PHONE

o7

® Connecting to a computer through RS232 (RS232 Adapter is optional)
F\ [/ '\‘I

RS232

e
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» Connecting to speaker
—_— //_;-\"‘. _

@ (),\ @ ) (o Speaker

USB  RS23. PHONE '\.‘r

—

<Remark>: Or connect to an additional amplifier before connecting
to the speaker

» Connecting to microphone

=~/ 3 o

L
(©)
©

n

Microphone

USB  RS232 PHONE. MIC
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4.4 Start using the DC260

Control Panel Remote Control

@) | Auto
[ Lamp Tune  Sourge
L&D |
SOURCE PUWER |
[
|
| AF Photo

| 1 Text

Capture

| Zoom + |

LAMP AUTO TUNE | l

ZOOM +

| Zoom - |

® When using the remote control, aim at the receptor on the DC260,
and press the power button.

® Once DC260 is turned on, the LED on the control panel will flash a
few times and stay lit. Please contact your distributor if the LED is not
on.

<Note> Once the password page is shown , please key in the

password. If you forget it, please contact your distributor or the

service center.

4.5 Installing remote control holder

Insert the holder over the gooseneck of the camera and push it down.
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4.6 Installing driver and application queue

After installing the USB driver and application queue, you can use the following
functions via the software:
» Control the DC260.

» Capture and record images.

» Annotate the image, highlight important details and save it.
» Supports the full screen function.

4.6.1 System requirements

X9
Resolution:
1024x768
Minimum Hard
Disc Space
Required:
100MB

Minimum Hard Disc
Space Required:
100MB

Operating . . . MAC OS X
Windows XP Windows Vista
System v10.4.10, v10.5
Minimum CPU: P4 2.8 CPU: P4 2.8 GHz CPU: PowerPC G4
System GHz and and above 866MHz®or Intel
G above Memory: 1GB Pentium™ 1.83GHz
q Memory: 512M Support Direct X 9 Intel Core 2 Duo
ments B Resolution: processor
Support Direct 1024x768 Memory: 512MB

1,024x768 screen
resolution and 24-bit
color display
Minimum Hard Disc
Space Required:
1GB

QuickTime 7.4.5
above

4.6.2 Installation steps (PC)

1.  Please download the software queue at the following URL:
http://www.lumens.com.tw/goto.htm

2. Refer to Chapter 4 Installation and Connections for USB
connection.

3. Turn on the DC260.
4. Select the preferred language and press [Next]

Lumens’
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5.

- InstallShield Wizand

queue

Choose Setup Language

Select the language for the installaion from the choices below.

Chinese (T radition ]

Select the preferred language and press [Next].

InstallShield Wizard

queue -

License Agreement
Flease read the following license agreement carefully,

Lumens Digtal Optics Inc. Saftwars License Agieement -~
IATTENTION: USE OF THE SOFTWARE IS SUBJECT TO THE LUMENS SOFTWARE
LICENSE TERMS SET FORTH BELOW.
Lumens Digital Optics Inc. Software License Tems -
The following License Tems govem your use of the acoompanying S oftware unless you
ave a separate wiitten agreement with Lumens.
1. License Grant
Lumens grants you a ficense to Lise one copy of the Software. “se! means staiing,
loading, instaling, execuling or displaying the Software. You may not modify the Software
ot disable: an izensing or control leatures of the Software.
2. Dwnership v

@i gecept the tems of the oense agreement

O donot ascent the terms of the license agresment

queue

- InstallShield Wizard

Choose Destination Location
Select falder where setup wil instal il

@

Install queue to
C:\Program Files\queus

queue - InstallShield Wizard

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

IF you want ta review or change any of wour installation settings, elick Back. Click Cancel to exit
the wizan

queue - InstallShield Wizard

InstallShield Wizard Complete

The Instalishield Wizard has successfuly instaled queue.
Click Finish o exit the wizard.

< Back Cancel

InstallShieid Wizard =

Twielcome (o the IntalS hield Wizard for Visual
Presente V2

[&l

The Ingtalfseskd® wizasd vl natall Visual Presenter Vi on
your comguer. To conbnue. chok Med.

SEAE]S i)

Cancel |

InztalfShield Wizard

Licansn Agrmmant . 4
Piesae read the fokowng icense agresment cashly

L TS e s——

Wosrmrs Digplel Opfcs b Sellvaain Licwran Agnerresd -

AT TENTION: USE OF THE SOFTWARE |8 SURIECT TO THE LUMENS SOFTWARE
LOCENSE TEFIIJSS!T FORTHBELDW.

Luares Dl Solimarn Licarse Tetns
wi || T Qimin yous' urees o
harve & separate wniten agreement wih Lumen:.

1 Lioenee G

ot
Lumeni grants you a oense |0 e one copy of T Soltware "Use” mosns itom,
[y, inslaling, scpcuting oo diapliparg the olivare Vou ray nol nodly P Soltma

Do yesi st o8 boemt o the peconteng Licirm Agrmmesers 7§ pou chionus o,
g el chon - T il Vil Presentes V2, pou il accepd e ageesment

umens
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6. Please select Continue

iz et ol laticin w

"} The softvesse o s inttsling for this hadwas:
Winsal Pregente V2

hiaw ok paszed 'windowe Loge imsing bo vesly #1 compaibdy
with Winckowss <F' [Tl rep why thee Sestng it mportant |

Conbe i of s soft
wmmmmmdmmm
withoi smmechalcly o in the fubwe. Micresel] sliongly
recnmmends that pou Slog Dhis molalstion Frirs aiil
comlact the hawdware vendon lor softmare that has
pacrad Wirdow: Logo testing

i

T mositwiames jois e inctaling foc ths nesscee:

Winusl Poesentes duudio W2

han net passed ‘'windows Logo insing o vesdy ks compalioliy

st wehckowen X (T el st thi heqting in evportand |

Conkinuing yous inslallatson of this

o deglahilien the covect nﬁn

withe mnmedhalnly o in Itl:-
Hhis s slabioon

o
hiz ﬂw
eCoEndE thal pou il
contact the hardware verdor for soltware that has
paered Wimdnee Logo teting.

[ Cortram vy | [ STOP insalaton |

[ Cortrmse ryviay | [[STOF Installaiion

7. Once the installation is completed, press [Finish] to reboot the
system.

InstallShield Wizard

InstallS hield Wizard Complete

The Install ield wizard has sucoessiull installed Lumens
Visual Presenter. Before pou can use the pragram, pou must
restart your computer.

& FFes. T Want to 1estart my computer now
Mo, | wil restart my computer later.

Remove any disks fiom thei diives, and then click Finish lo
complete setup.

< Back Cancel

4.6.3 Installation steps (MAC)

1.  Please download the software queue at the following URL:
http://www.lumens.com.tw/goto.htm

2. Refer to Chapter 4 Installation and Connections for USB
connection.

3. Turn on the DC260.

4.  Select [queue] to begin installation and follow the screen instructions

- — [ Lumens queue

Lumens queue  Gueue install.zip

@ Network

| g Macintosh HD
| -{ﬂ Untitled

%

Lumens queue Uninstall

Lumens’
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4.6.4Verifying the installation is completed (PC)
1. Double click the queue shortcut on the desktop or click [Program] >

[Start] > [Programs] > [queue]

& quene

: L. ¥ BN Uninstall queve

<Remark> Please refer to the User Manual of queue for how to use it.
(Please download it from the website below
http://www.lumens.com.tw/goto.htm).

4.6.5Verifying the installation is completed (MAC)
1.  Click [Applications] > [queue]

'B (13 | A Applications
a4 » 88 = 00 || 4~

@ Network & I | = :
= ® a
A Macintosh HD i ‘

"
3 E ‘ Preview QuickTime Player
. zé Untitled

Oy Allinone & Q
1

m Desktop | !
2
& sw ‘ ._./ =
“,,.M o ‘ TextEdit Utilities
g ovi |
|
=
| |l Pictures | @
é Music i‘ queue

39 items, 3.8 GB available

<Remark> Please refer to the User Manual of queue for how to use it.
(Please download it from the website below
http://www.lumens.com.tw/goto.htm).
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Chapter 5 DIP Switch Settings

<Note> You have to reset the unit for setting to take affect.

5.1 Connecting to a projector or monitor
5.1.1 XGA 60Hz output (default values):

N
m|:
»

5.1.2 SXGA 60 Hz output

] !

5.1.3 HDTV 720P 50Hz output

—_— S

1

5.1.4 HDTV 720P 60Hz output

[ ] ¢ 1
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5.2 Connectingtoa TV

5.2.1 NTSC: America, Taiwan, Panama, Philippines, Canada,
Chile, Japan, Korea and Mexico

t

5.2.2 PAL: Countries/regions not listed above.

2 T 3

2 T 3

<Remark> VGA output is not supported once C-Video output has

been enabled.

Lumens’

English - 22




Chapter 6 Control Panel/Remote Control
and Setting Menu

6.1 Functions of control panel and remote control

<Note> You are unable to use the [Menu] / [Rotate] / [Half Page] / [Source] /
[Record] / [Capture] / [Delete] / [PBP] / [Slide Show] functions in C-Video
mode.
<Remark> The below functions are listed alphabetically.

Function Operation
Turn on and off the visual presenter. Remote control /
Control panel
O AV Move up, down, left or right to select the needed | Remote control /
function. Control panel
AF Automatically adjust focal length on an object. Remote control /
Camera Head
Auto Tune | Automatically adjust the image to have the best Remote control /
brightness and focusing performance. Control panel
BRT+/- Manually adjust the brightness of the image. Remote control
Capture Capture the image to the SD card (priority) or Remote control /
internal memory. Control panel
Delete Delete the image stored in the SD card (priority) | Remote control /
or internal memory. Control panel
Enter Enter/Activate functions. Remote control /
Control panel
Focus +/- Manually adjust focal length on an object. Remote control /
Control panel
Freeze Freeze the current image to temporarily stay on Remote control /
the screen. Press again to defreeze. Control panel
Half Page Turn on/turn off the Half Page function. Pressing | Remote control /
[Half Page] once will display the upper half of the | Control panel
live image, while pressing [Half Page] twice will
show the lower half of the live image. Press [Half
Page] again to exit this function.
Lumens English - 23




Lamp Turn on / off the lamp. Remote control /
Control panel
M Scope Enter the microscope mode. Press again to Remote control
return to the previous mode.
Menu Activate the setting menu function/exit menu. Remote control /
Control panel
Mode Select general/slide/negative/microscope mode. | Remote control
PBP PBP (Picture by picture): Compare live images Remote control
with captured image files.
Photo/ Text | Select photo, text or grayscale image mode. Remote control
Refer to DC260 User Manual Chapter 7
Descriptions of major functions 7.2 | would
like to make text clearer and photos more
colorful
Record Record motion images. Press [Record] to record | Remote control /
images to SD card (priority) or internal memory; | Control panel
press[Record]again to stop recording.
Rotate Rotate the image by 0°/90°/180°/270°. Remote control /
Control panel
Slide Show | Show the photos or videos stored in the SD card | Remote control
(priority) or internal memory in slide mode.
Source Switch between different sources of signals: Remote control /
1. Live images (default) Control panel
2. SD card (priority) or internal memory
3. Computer
Zoom +/- Increase or decrease the image size. Remote control /

Control panel

Lumens’
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6.2 Setting Menu

<Remark> Press [Menu] on the remote control or control panel to enter the
setting menu; The bold underlined values in the following table are the

defaults.

1% Level
Major
Items

2" Level
Minor Items

3 Level
Adjustment
values

Descriptions

Display

Brightness

0~Max

Use the left and right arrow
keys to adjust the brightness.

Mode

Normal/Slide/
Film/Microscope

Use the left and right arrow
keys to select the image
mode.

Photo/Text

Photo/Text/Gray

Use the left and right arrow
keys to select the image
mode.

Refer to DC260 User Manual
Chapter 7 Descriptions of
major functions 7.2 | would
like to make text clearer and
photos more colorful

PBP

Enter

Press [Enter] to immediately
activate photo comparison
mode. Refer to DC260 User
Manual Chapter 7
Descriptions of major_
functions 7.15 | would like
to compare images

Night Vision

On/Off

Use the left and right arrow
keys to select. The night
vision mode suits with darker
environment.

Digital Zoom

On/Off

Use the left and right arrow
keys to turn digital zoom
on/off.

Lumens’
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Press [Enter] to play the
photos or videos stored in the
SD card (priority) or internal
. memory. Refer to DC260
Storage Slide Show Enter User Manual Cha_pter 7
Descriptions of major
functions 7.14 | would like
to play the slides
1. Off
2. Shutter
Slide Show 3. Right Use the left and right arrow
Effect 4 D keys to select the image
- bown switch mode.
5. Side
6. Open
1. 1Sec
2. 3Sec Use the left and right arrow
keys to select the delay time.
Delay 3. 5Sec ]
Select manual mode to switch
4. 10 Sec images manually.
5. Manual
Press [Enter] to immediately
Copy To SD Enter copy the data in visual
presenter to the SD card.
Use the left and right arrow
keys to select, and then press
[Enter] to confirm the deletion
Delete All Yes/No of photos.
Delete the image stored in the
SD card (priority) or internal
memory.
Use the left and right arrow
keys to select, and then press
Format Yes/No [Enter] to format the data
stored in the SD card (priority)
or internal memory.
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1. High Use the left and right arrow
. . keys to select the image
Image Quality Medium quality for the captured
Low images and recorded videos.
1. Sindle Use the left and right arrow
Setting Capture 5 Continuous keys to select the video
3. Disable capture mode.
' (Single/Continuous/Disable)
1. 1hr Use the left and right arrow
2. 2hr keys to set the capture time.
Capture Time | 3. 4hr <Remark> It only works when
4. 8hr the capture mode is set to
5 24 hr [continuous].
1. 5sec
210 sec Use the left and right arrow
Capture 3. 30 sec .keys to set the capture
. interval. <Remark> It only
Interval 4. 1 min
) works when the capture mode
5. 2 min is set to [continuous]
6. 5min
Use the left and right arrow
keys to select the USB
transfer mode.
1.Camera: connecting the
1. Camera DC260 to view live image;
2.Storage device: connecting
USB Transfer | 5. Storage to the SD card (priority) or
device internal memory.
Refer to DC260 User Manual
Chapter 7 Descriptions of
major functions 7.20
Computer-related functions
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AE

On/Off

Regardless of outside
environment, the machine will
adjust the brightness to the
optimal condition.

Use the left and right arrow
keys to select.

AWB

Regardless of outside light or
color, the machine will adjust
the color to the optimal
condition. Press [Enter] to
activate.

Digital Zoom

On/Off

Use the left and right arrow
keys to turn digital zoom
on/off.

Noise
Reduction

On/Off

Use the left and right arrow
keys to turn on/off the noise
reduction function. Refer to
DC260 User Manual Chapter
7 Descriptions of major
functions 7.17 | would like
to reduce the image noise

Volume

0~Max

Use the left and right arrow
keys to adjust the volume.
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1. English English
2. Bk Traditional Chinese
3. Deutsch German
4. Francais French
5. ltaliano Italian
6. Espanol Spanish
Advance | Language 7. Pycckun Russian
8. Nederlands Dutch
9. Suomi Finnish
10. Polski Polish
Use the left and right arrow
keys in the language option to
select the preferred language.
1. XGA Using UXGA - set the DIP
2 SXGA switch for XGA, select UXGA
for OSD
3. UXGA Using 1080P - set the DIP
4. 720P switch as 720P, select 1080p
5. 1080P for OSD
Output Mode Based on different DIP switch
settings, different output
modes are provided. Refer to
Chapter 5 DIP “Switch
Settings” in the DC260 user
manual.
Use the left and right arrow
keys to turn the lock down
function on and off. You can
set the password when [On]is
selected. Refer to DC260
Lock Down On/Off User Manual Chapter 7
Descriptions of major_
functions 7.18 | would like
to set / change the
password
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Auto Erase

On/Off

Use the left and right arrow
keys to turn the auto erase
function on and off. When
[On] is selected, the saved
images will automatically be
deleted when the system is
turned off.

Refer to DC260 User Manual
Chapter 7 Descriptions of
major functions 7.11 | would
like to automatically delete
the captured images
whenever it is turned off

Preset Load

Yes/No

Read the value of the current
image mode.

Use the left and right arrow
keys to select, and then press
[Enter] to confirm.

Preset Save

Yes/No

Save the value of the current
image mode.

Use the left and right arrow
keys to select, and then press
[Enter] to confirm.

Factory Reset

Yes/No

Use the left and right arrow
keys to select, and then
immediately press [Enter] to
activate the factory reset.

Refer to DC260 User Manual
Chapter 7 Descriptions of
major functions 7.16 |
would like to resume the
factory default setting
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Chapter 7 Descriptions of major functions

7.1 1 would like to switch image sources

Live image is the default of image source. Press [Source] on the remote
control or control panel to change:

1. Live images (default)

2. SD card (priority) or internal memory

3. Computer.

7.2 1 would like to make text clearer and photos more
colorful

Photo is the default. You can change setting via the remote control or
control panel.
Remote control:
1. You can rotate between photo, text, and gray:
® [Photo] (default): for viewing photos or text with photos and will make
the photos more colorful.
® [Text]: for viewing text files and will make the text clearer.
® [Gray]: for viewing black and white photos and will make the
grayscale differentiation more distinct.
Control panel:
1. Press [MENU] to enter the setting menu.
2. Press [»] or [«] to select [Display].
3. Press [¥] to select [Photo/Text].
4. Press [»] or [4] to select [Photo/Text/Gray] (Refer to the description
above).
5. Press [MENU] to exit.

7.3 1 would like to zoom in /out of images

1. Press [Zoom +] on the remote control or control panel to zoom in.
2. Press [Zoom -] on the remote control or control panel to zoom out.
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7.4 | would like to use the auto focus

1. Press [AF] on the remote control.
2. Press the AF button on the camera head of main unit.

7.5 | would like to adjust the brightness

Remote control:
1. Press [BRT +] to make it brighter.
2. Press [BRT -] to make it darker.
Control panel:
1. Press [MENU] to enter the setting menu.
2. Press [»] or [4] to select [Display].
3. Press [v] to select [Brightness].
4. Press [»] or [4] to adjust the value.

7.6 1 would like to turn on/ off the lamp

1. The default of lamp is turn on. Press [Lamp] on the remote control or
control panel to turn off.

7.7 1 would like to automatically adjust the image to have
best brightness and focusing performance

1. Press [Auto Tune] on the remote control or control panel.

7.8 1 would like to capture images
7.8.1 Setting the quality of captured images

1. Press [Menu] on the remote control or control panel to enter
the setting menu.

. Press [»] or [4] to the [Storage] menu.

. Press [v] to find [Image Quality].

. Press [»] or [4] to select among [High/Medium/Low].

. Press [Menu] to exit.

a b~ ON
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7.8.2 Setting continuous capture

1. Press [Menu] on the remote control or control panel to enter
the setting menu.

2. Press [»] or [4] to the [Setting] menu.

3. Press [v] to find [Capture].

4. Press [»] or [ €] to select [continuous].

5. Press [v] to find [Capture Time]; Press [»] or [ 4] to select time
settings.

6. Press [v] to find [Capture Interval]; Press [»>] or [«] to select time
settings.

7. Press [Menu] to exit.

7.8.3 Capturing and saving images

1. Press [Capture] on the remote control or control panel.

7.9 | would like to view captured images

1. Press [Source] on the remote control or control panel to display
thumbnails of all captured images.

. Press [A]or[v] or [»] or [4] to select the thumbnail you want you view.

. Press [Enter] for the full-screen display of the image.

. Press [»] or [4] to turn to the previous/next image.

. Press [Source] to exit.

a b~ WODN

7.10 | would like to delete captured images

—_

. Press [Source] on the remote control or control panel.

. Press [A]or [v] or [»] or [4] to select the thumbnail you want you
delete.

. Pressing [Del] will open a [Delete File] window.

. Press [»] or [4] to select [Yes] (The default value is No).

. Press [Enter] to delete the selected photo.

. Press [Source] to exit.

N

[©20N6) I~ V)
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7.11 | would like to automatically delete the captured
images whenever it is turned off (Auto Erase)

1.

NOoO b WN

Press [Menu] on the remote control or control panel to enter the
setting menu.

. Press [»] or [4] to access the [Advance] menu.

. Press [A] or [¥] to [Auto Erase].

. Press [»] to select [On].

. Press [»] or [ 4] to select [OK].

. Press [Menu] to exit.

. It will automatically delete all captured photos when it is turned off.

7.12 | would like to record and play videos

7.12.1 Setting the image quality

1. Press [Menu] on the remote control or control panel to enter the
setting menu.

2. Press [»] or [4] to the [Storage] menu.

3. Press [v] to find [Image Quality].

4. Press [»] or [4] to select among [High/Medium/Low].

5. Press [Menu] to exit.

2 Recording videos

1. Press [Record] on the remote control or control panel to start
recording videos.

2. Simultaneously record sounds with the built-in microphone of the

control panel or the microphone connected to the MIC port.

3. Press [Record] again to stop recording.
[Note] The MIC port cannot be connected to an amplifier before

connecting to the microphone.

7.12.3 Playing videos

1. Press [Source] on the remote control or control panel to display
thumbnails of all video recorded.
2. Press [A]or[v]or[»] or [4] to select the thumbnail you want you

view.

3. Press [Enter] for full-screen play
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4. Press [»] or [4] to turn to the previous/next video.

5. Press [Source] to exit.

[Note] Only the MOV files recorded can be played and live sound
output is not available; additional amplifier can be connected to
the PHONE port.

7.13 | would like to switch the view between the upper and
lower half of the image (Half Page)

1. Press [Half Page] on the remote control or control panel and the
upper half of the live image will be displayed.

2. When you press [Half Page] again, the lower half of the live image will
be displayed.

3. Press [Half Page] again to exit this function and return to the live image.

<Notes> This function is not available under Microscope Mode. The

Zoom in / out function is not available when this function is activated.

7.14 1 would like to play the slides (Slide Show)

7.14.1 Setting the slide show effect

1.

w

5.

Press [Menu] on the remote control or control panel to enter
the setting menu.

. Press [»] or [4] to access the [Storage] menu.
. Press [v] to find the [Slide Show Effect].
. Press [»] or [4] to select image switch mode between [Off /

Shutter / Right / Down / Side / Open].
Press [Menu] to exit.

7.14.2 Setting delay time

1.

w

Press [Menu] on the remote control or control panel to enter
the setting menu.

. Press [»] or [«] to access the [Storage] menu.
. Press [v] to find the [Delay].
. Press [»] or [ 4] to select image switch mode between [1 Sec/ 3

Sec /5 Sec /10 Sec / Manual].

. Press [Menu] to exit.
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7.14.3 Activating/Stopping the slide show

<Notes>Images over 8 MB, cannot be played. Whilst playing, the
[Rotate] function can be activated to rotate the images.

Remote control:

1. Press [Slide Show] to start playing.

2. Press [Slide Show] again to stop playing.
Control panel:

1. Press [Menu] to enter the setting menu.

2. Press [»] or [¢] to access the [Storage] menu.

3. Press [v] to find [Slide Show]
4. Press [Enter] to play.
5. To stop playing, repeat steps 1 to 4.

7.15 1 would like to compare images (Compare live images

with captured images) (PBP, Picture by Picture)

This function will compare and contrast a live image with a captured image.

c1 Cc2
C3 C4
C5

Remote control:
1. Press [PBP] to enter the PBP (Picture by Picture) photo selection

screen.

Captured Image

Live Image

2. Press [A]or[v]or[»] or [4] to select the files to be compared.

w

. Press [Enter] to activate the image comparison.

4. Press [»] or [4] to move the images (captured images only)

leftward/rightward.

5. Press [PBP] to exit.
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Control panel:

1. Press [Menu] to enter the setting menu.

2. Press [»] or [4] to access the [Display] menu.

3. Press [v]to find[PBP]

4. Press [Enter] to enter the PBP (Picture by Picture) photo selection
screen.

. Press [A]or [v] or [»] or [4] to select the files to be compared.

. Press [Enter] to activate the image comparison.

7. Press [»] or [4] to move the images (captured images only)

leftward/rightward.
8. Press [Menu] again to return to image thumbnails.
9. Press [Source] to exit.

[e20Né)!

7.16 1 would like to resume the factory default setting
(Factory Reset)

1. Press[Menu]on the remote control or control panel to enter the
setting menu

. Press [»] or [«] to access the [Advance] menu.

. Press [ v] to select [Factory Reset].

. Press [»] or [«] to select [Yes].

. Press [Enter] to activate.

a b WODN

7.17 1 would like to reduce the image noise (Noise
Reduction)

This function enables visual presenter to automatically clear image noise.
The noise is especially obvious when Visual presenter is connected to a
DLP projector. You can use this function to improve the image quality.
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1. Press [Menu] on the remote control or control panel to enter the
setting menu.

2. Press [»] or [«] to the [Setting].

3. Press [v] to find [Noise Reduction].

4. Press [»] or [«] to select [On].

7.18 1 would like to set / change the password (Lock Down)

7.18.1 Setting the password

. Press [Menu] on the control panel to enter the setting menu.
. Press [»] or [«] to the [Advance] menu.

. Press [v] to [Lock Down].

. Press [»] or [«4] to select [On].

. The screen will be displayed, as shown below.

a b WON -

Key in Password

6. Key in the password
Press the keys on the control panel. All keys can be used as part of
the password except the [Power] and [Enter] keys. The maximum
number of characters is 2. For example, you can press [Source] +
[Menu] as the password.
<Remark>The screen will show * while you enter the password.
Ensure that you remember the order in which the keys are
entered.

7. After completing the password, press [Enter].

8. The confirmation screen will be displayed, as shown below. Enter the
password again.

Confirm password

9. After you enter the password, press [Enter].
If the password is entered correctly, setup is completed. If the
password is incorrect, an error message is displayed and please
follows the screen instructions.
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7.18.2 Changing the password

1. Press [Menu] on the control panel to enter the setting menu.

2. Press [»] or [«] to the [Advance] menu.

3. Press [v] to [Lock Down]

4. Press [»] or [4] to select [Off] and deactivate the password
setting function.

5. Press [»] or [¢] to select [On] and reactivate the password
setting function. Refer to Steps 5-8 in DC260 User Manual
Chapter 7 Descriptions of major functions 7.18 | would like
to set / change the password for operational steps.

7.19 Using a SD card

7.19.1 Deactivate the write protect function (SD Lock)

If the write protect function of the SD card is activated, you will not be able
to use the Capture function, although you can still read the files in it.
Adjust the Lock of the SD card to deactivate the write protect function.

o f By

LOCK vE

7.19.2 Inserting a SD card

7.19.2.1 The screen will display [Copy to SD card] and ask if you
would like to copy the files saved in the DC260 to a SD card.
» Press [»] or [4] on the control panel to select.

Copy to SD Card

7.19.2.2 The screen will display as follow, once you insert an
unformatted SD card.
» Press [»] or [4] on the control panel to select.

Format SD Card

} YES
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<Note> The data previously saved on the SD card will be
erased when it is formatting.

7.19.3 Ejecting a SD card

<Note> Turn the power off before ejecting the SD card to
avoid damaging the SD card.

7.20 Computer-related functions

Ensure that the USB cable is connected and the drivers are installed
before using the computer-related functions. Refer to DC260 User Manual
Chapter 4 Installation and Connections 4.3 Connecting Devices and
4.6 Installing Driver and Application gueue.

7.20.1 | would like to insert a photo in MS-Paint

1. Click File> From Scanner or Camera in MS-Paint shown as the

bottom left figure.

|I!"|' untitle d _ Pﬂ] nt S Capture Pictures from Video

N Edit View Image ¢olors Help Ulatel (PR @10 i ER D Eep

Click the Capture button to create & picturs fram the video. Then select the picture you want ta
New ChFN refiieve and click Get Picture to bring it into your application.
Qpen. .. Chr+0 2
Save Chrl+5
Save As. .,
Fram Scanner or Camera. ..

I v

Prink Preview
Page Setup...
Print Chri+p

2. Click [Get Picture] will capture the photos of live images and insert

the files in use shown as top right figure.
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7.20.2 | would like to insert a photo in MS-Word

1. Click Insert > Image > From Scanner or Camera in MS-Word.

0§ Document - Microsoft Word

! File Edit Miew | Insert | Formak  Tools  Tahl

le  Window Help
RN N = N Break... B9 - @ 3G 0w -
Page Mumbers... R T
Symbal. ..
Mumber...
Picture P &l dip A
Text Box b || FromFie. ..
% Hyperlink...  Ctrl+K a From Scanner or Camera, ., |
¥ G AutoShapes

2. Select [Visual Presenter V2] and click [Custom Insert].

Insert Picture from Scanner or Camera [g|

Device

Resolution: (3) web Quality O Print Guality

Add Pictures to Clip Organizer

[. Insert ] [gustom Insert ] [ Caricel ]

3. Click [Get Picture]. It will capture the photo of live image.

5 Capture Pictures from Video E

Which picture do you wantto copy?

Click the Capture button ta create a picture from the video, Then select the picture pou want to
retrieve and click Get Picture to bring it into your application.

_

| >

<
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7.20.3 | would like to change the setting of DC260 then capture a
photo in MS-Word

1. Click Insert > Image > From Scanner or Camera in MS-Word.

T4 Document] - Microsoft Word

i File Edit Wiew | Insert | Format  Tools  Table Window  Help

I = W Breah B9 . @ @& wes g

Page Mumbers, .. IR 2

Symbal...
Mumber. ..
Picture P&l Cip At
Text Box v [ FromFile...

% Hyperlink...  Ctrl+ |§ From Scanner or Camera...
g e

Autoshapes

2. Select [Visual Presenter V2 TWAIN] and click [Custom Insert].

Insert Picture from Scanner or Camera

Cevice

'-.-'i::u-al Presenter Y2 TWAIH

Resalution: (3) Web Cuality ) Brink Cuality

Add Pictures to Clip Organizer

[, Insert ] [gustom Insert ] [_ Cancel _]

3. A window showing a live image (see below) will be displayed.

Insert Captured Image

Setting Capture Cancel
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4. Press [Setting] to

control the DC260 via the Camera Settings

interface. The operating procedure is the same with the remote
control and control panel of the DC260. Refer to DC260 User
Manual Chapter 6 Control Panel / Remote Control and Setting

Menu.

5. Press [Setting] to
6. Press [Cancel] to
7.20.4 1 would like to se

capture images in MS-Word.
exit.
t the DC260 as a webcam for Skype

The DC260 can be used as a webcam for teleconferencing software

such as Skype and MSN.

example.

1. Open Skype and enter

2. Select [Video Settings]
Start my video automat

n

A General

=) General Settings

P

&) #udio settings

A o 3

(=) vides Settings

R ..
N Privacy

P notifications
@ cais

© chats & svs

£ Advanced

Video Settings: set

The following instructions use Skype as an

Tools > Options....
> [webcam] > [Visual Presenter V2] and check
ically when | am in a call, as shown below.

S Skype™ - Options E f\@

up your webcam

Enable Skype Video

T Start my video automatically when T amin a cal

Select welTam

Visual Presenter D
e

Show that I have video to...

(

Automatically receive video from...
(O anyone (&) people in my Contact List
@ only people in my Conkact List Onoone

O naone

@ Leam mare about setting up your webcam

@) 5uy 2 web camera from the Skype Shop

Cancel

Save
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3. Start calling your contact. When both sides are connected, Skype will

display the video screen.

15 Skype™ - san.chen (A=)

Ele account Call Chats tew Toos Help
@~ san OOO 314

B Callchesply to mobie phones and landlines

0 AddCalers 2 v DaMore

 alfred OO0 274

(V] B ¢ O Qanednonza

O+t R Callwith Afred 000 274 7,543,414 peop.

7.20.5 | would like to set the DC260 as a PC Camera

1. Press [Menu] on the control panel to enter the setting menu.

2. Press [»] or [ 4] to the [Setting] menu.

3. Press [v] to find [USB Transfer].
4. Press [»] or [4] to select [Camera].

5. A window will be displayed, showing the [Visual Presenter V2], as

shown below

1 Fites Stored on This Compater
=

4 =
Sured s
Douumerts  Documents

- S
tocdDuk(Cr)  Deta B}
Devices with Removable Storage

4 &

-
34 Floggy €D D (E4)

(41

Seanevers and Cameras

vinasl
Praserter v2

6. Click the [Visual Presenter V2.
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7.20.6 | would like to set the DC260 as a Removable Disc

1. Press [Menu] on the control panel to enter the setting menu.

2. Press [»] or [ 4] to the [Setting] menu.

3. Press [v] to find [USB Transfer].

4. Press [»] or [4] to select [Storage device].

5. Press [Menu] to exit.

6. A Removable Disc will be displayed.

<Remark> The Removable Disc will select SD card if a SD card has
been inserted, but if a SD card has not been inserted, the Removable

Disc is internal memoi.

Ele Edit Wew Favorites Tools Help
J > ? / ) Search || Folders Elv

Address ) My Computer

Narme Type
rs
| System Tasks & Files Stored on This Computer
View system information 23 Shared Documents File Folder
7Y Add or remove programs [ 5%'s Documents File: Folder

[ Change asetting

é; Hard Disk Drives
S

|| e Local Disk (C:) Local Disk
|| S Data D) Local Disk.

Other Places

g My Network Flaces
.D My Documents
) Shared Documents
@ Control Panel

Devices with Removable Storage

S 34 Floppy (A1) 3%-Inch Floppy Disk.
D Drive (E: CD Drive

e Removable Disk (Fi) D Removable Disk

<Note> Doing this will disable the Capture function. Suggest you
return it to [Camera] mode after using this function. Please follow
the steps below.

1. Press [Menu] on the control panel to enter the setting menu.

2. Press [»] or [4] to the [Setting] menu.

3. Press [v] to find [USB Transfer].

4. Press [»] or [4] to select [Camera].

5. Press [Menu] to exit.
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7.20.7 | would like to connect Interactive Whiteboard

1.System diagram

Interactive Whiteboard
Visual Presenter
2. Using StarBoard
2.1 Install LuLulizer and execute “LulLulizer.exe”

<Note> Please download LuLulizer from the website
(www.lumens.com.tw/goto.htm)
2.2 Press [StarBoard] / [LULU]
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2.3 Display the live image.

2.4 Press [StarBoard] / [Mode] / [TWAIN]

Please refer to the operations of 7.20.2 | would like to insert a
photo in MS-Word and 7.20.3 | would like to change the
setting of DC260 then capture a photo in MS-Word

3. Using SmartBoard

3.1 Press [Insert] / [Picture From Scanner]

% b,

v & O[CDOOK

File  Edit Yiew Format Draw Help

&= &) | ¥ Blank Page Crrl+hd
—a ———  PRicture Fle

D E Picture From Scanner...

B 1 Fichire From SMART Docuwment Camera...

|1 Flash File...
Senteo Question...
é) AR : Senteo Title Page...
Flash ¥ideo File...

3.2 Please refer to the operations of 7.20.2 | would like to insert a
photo in MS-Word and 7.20.3 | would like to change the
setting of DC260 then capture a photo in MS-Word
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Chapter 8 Connecting to Microscope

1. Mount the microscope adaptor onto the microscope.
2. The lens of DC260 connects with the microscope adaptor.

3. Select the[Microscope]Mode
3.1.Press [M Scope]on the remote control (suggestion).
3.2.Control panel
3.2.1. Press [MENU] to enter the setting menu.
3.2.2. Press [»] or [4] to select [Display].
3.2.3. Press [v] to select [Mode].
3.2.4. Press [»] or [4] to select [Microscope].
4. If the image is not clear.
4.1.Please adjust the focus of microscope.
4.2.Press the AF button on the camera head of main unit to activate the
auto focus.
5. Digital Zoom
5.1.Press [MENU] to enter the setting menu.
5.2.Press [»] or [«] to select [Display].
5.3.Press [ ¥] to select [Digital Zoom].
5.4.Press [»] or [«] to select [On].
5.5.Press [Zoom +]/[Zoom -] on the remote control and control panel

<Note> In microscope mode all functions are available except for the
[Zoom +] /| [Zoom -] / [Half Page] functions on the remote control and
control panel. Please reset to normal mode after using the microscope,
otherwise, you are unable to use zoom in/out function.

1. Press [MENU] on the control panel to enter the setting menu.
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2. Press [»] or [4] to select [Display].
3. Press [v] to select [Mode].
4. Press [»] or [¢] to select [Normal].
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Chapter 9 Troubleshooting

This chapter describes problems you may encounter while using DC260. If you
have questions, please refer to related chapters and follow all the suggested
solutions. If the problem still occurred, please contact our distributors or service

center.

No. Issues Solutions

1 Boot without Make sure you have plugged in the power cord.
power

2 No image output 1. Check the power.

from the DC260

2. Check the connection, Refer to DC260 User
Manual Chapter 4 Installation and
Connections 4.3 Connecting Devices

3. Check the [Source], refer to DC260 User Manual
Chapter 7 Descriptions of major functions 7.1
| would like to switch image sources

4. Check the settings for the source of the
projector. For the appropriate input selection of
the projector, refer to the projectors user manual

5. Check if DIP Switch is properly set. Refer to
DC260 User Manual Chapter 5 DIP Switch
Settings for related settings.

3 Unable to focus

Probably the document is too close. Press [zoom -]
on the remote control or control panel. Or pull
away the distance between document and lens, then
press [AF].

4 The image is
incomplete

Check the Auto Image setting of your
projector. Please refer to the user manual of the
projector.

5 Forget the
password for
turning on

Please contact your distributor or the service center.

6 Visual Presenter
V2, queue or other
application cannot
be executed
simultaneously.

Visual Presenter V2, queue and other applications
cannot be executed simultaneously. Only one
application can be executed at a time. Please close
the currently running applications and then execute
the application to be used.
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